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1.1 INTRODUCING MOUNT IMAGE PRO 

Mount Image Pro is a utility used to mount forensic forensic-images or physical devices under Windows. A 

mounted drive can be then examined in a forensically sound environment. 

Figure 1, Mount Image Pro v7 

 

Figure 2, Mount Image Pro v5 GUI 

 

1.1.1 PROGRAM USES 

Mount Image Pro is primarily used by computer forensic examiners, investigators, and lawyers. It facilitates 

fast access to the contents of physical disks or forensic forensic-images in a read-only environment without the 

need for high end forensic software. Mount Image Pro is commonly used to: 

¶ Quickly browse the contents of a mounted drive using familiar programs such as Windows Explorer; 

¶ Run third party programs on mounted drives, including: 

o Virus scanners, spyware, Trojan and malware tools. 

o Stenography tools. 
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o Keyword indexing tools. 

o Data recovery programs. 

o  Other forensic programs that require disk access. 

1.1.2 SUPPORTED IMAGE FORMATS 

Mount Image Pro supports mounting of the following file formats: 

¶ Access Data .AD1; 

¶ Apple DMG; 

¶ EnCase .E01, Ex01, .L01, Lx01; 

¶ Forensic File Format .AFF; 

¶ ISO (CD and DVD images); 

¶ Microsoft VHD; 

¶ NUIX MFS01; 

¶ ProDiscover; 

¶ SMART; 

¶ Unix/Linux DD and RAW images; 

¶ VMWare. 

¶ Xways Container File. 

1.1.3 PROGRAM FEATURES 

Mount Image Pro features include: 

¶ Mount as read only or simulate disk writes. 

¶ Mount the physical drives into Windows disk management. 

¶ Mount from the command line. 

¶ Mount Logical Evidence Files (LEF) created by EnCase® and FTK. 

¶ Mounts NTFS, FAT, FAT16, FAT32 and HFS, APFS file systems. 

¶ Is compatible with third party file system drives such as HPFS, Linux EXT2/3/4. 

¶ Works with physical and logical images. 

¶ Mount images via a network from a central server. 
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¶ Create DOS batch files to mount multiple images. 

¶ Show or hide deleted files. 

¶ Mount files without Windows security permissions. 

¶ Mount RAID devices.  
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2.1 SYSTEM REQUIREMENTS 

Administrator: It is recommended to install and use Mount Image Pro as local administrator user (or at a 

minimum a user account with full administrator rights). 

Windows UAC: It is recommended to use Mount Image Pro with Windows User Account Control (UAC) 

disabled (or at a minimum set to low). 

Hardware/OS: Mount Image Pro requires the following minimum specification: 

¶ Windows XP, 2003, Vista, Win 7, 2008, Win 8, 10, Server 2008-2016; 

¶ Pentium IV 1.4 GHz or faster processor; 

¶ 1GB RAM; 

¶ 32bit and/or 64bit compatible. 

Supports Third party file system drivers such as:  

¶ MAC: http://w ww.paragon-software.com/home/hfs-windows/; 

¶ EXT: http://www.paragon-software.com/home/extfs-windows-pro/.  

2.2 DOWNLOAD 

The latest version of Mount Image Pro is available for download at www.mountimage.com. The software 

requires activation with either: 

¶ A 30 day evaluation software key; 

¶ A purchased software key; 

¶ A purchased USB activation dongle. 

See Chapter 4 for more information. 

2.3 INSTALLATION 

Recommendations prior to installation: 

¶ Close then exit any running instance of Mount Image Pro present in the Windows task bar; 

¶ Uninstall previous versions. 

To install Mount Image Pro: 

¶ It is recommended that Mount Image Pro be installed as Administrator user (or an account with 

administrator privileges) so that disk driver installation has the maximum privilege available.  

http://www.paragon-software.com/home/hfs-windows/
http://www.paragon-software.com/home/extfs-windows-pro/
http://www.mountimage.com/


C h a p t e r  2 ς I n s t a l l a t i o n  1 1  |  P a g e 

 

 

 
© Copyright GetData Forensics 2002 - 2019, All rights reserved. 
 

¶ Run the installation file ForensicExplorer-Setup.exe (or ForensicExplorer-Evaluation-Setup.exe if you 

are installing the 30 day evaluation version).  

¶ Follow the setup instructions. 

Figure 3: Mount Image Pro installation 

 

1. Follow the setup instructions and confirm the setup summary by clicking the Install button; 
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Figure 4, Finalize installation 

 

2. A successful install will display the following screen. Click Finish to confirm. 

3. Run Mount Image Pro from the installed desktop icon: 

Figure 5, Desktop icon 

 

4. Mount Image Pro requires the installation of disk drivers. If prompted with the following message a 

system restart is required: 

Figure 6: Disk driver initialization 
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Upon restart, check that the drives are installed correctly, as shown in xx below: 

Figure 7, Mount Image Pro drivers 

 

5. At the completion of the installation, confirm the drive status in the information bar at the bottom of 

the Mount Image Pro GUI. If the status Disk Driver not installed, reboot the PC. If this message 

continues, check user privileges and/or security software that may be blocking driver installation and 

reinstall. 

2.3.1 SILENT INSTALLATION 

Some third party vendors require silent Mount Image Pro installation (i.e. the GUI is not visible to the end 

user). To execute a silent installation, use the following Command Line options: 

"C:\ DownloadsMIP-Setup.exe" /AUTOREG=XXXX-XXXX-XXXX /VERYSILENT 

Where the path points to the setup file and XXXX-XXXX-XXXX is replaced by the product activation key. Ensure 

that:  

1. aƻǳƴǘ LƳŀƎŜ tǊƻ ƛǎ ƴƻǘ ŀƭǊŜŀŘȅ ǊǳƴƴƛƴƎ ƻƴ ǘƘŜ ǳǎŜǊΩǎ ŎƻƳǇǳǘŜǊΤ 

2. Activations are available on the key. 

2.3.2 WINDOWS AUTOPLAY SETTING 

When a disk is mounted the Windows Control Panel > AutoPlay options determine whether Windows 

Explorer is automatically launched. This option can be turned off in the Removable Drives options by selecting 

Take No Action.   

2.4 UNINSTALL MOUNT IMAGE PRO 

To uninstall Mount Image Pro: 

1. Unmount all drives. 

2. If Mount Image Pro appears in the Windows Task bar, right click on the task bar icon and select Exit. 
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3. From Windows > Start > All Programs > Mount Image Pro select the uninstall option; or Use Control 

Panel > Uninstall; and follow the installation prompts. 

 Any remaining folders in the Program Files installation path can be removed manually. 
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3.1 PURCHASE 

Mount Image Pro is available for purchase online, via purchase order, or via forensic software resellers. 

3.1.1 {hC¢²!w9 Y9¸ ±Ω{ 5hbGLE ACTIVATION 

Mount Image Pro is sold with a software activation key which is provided at the time of purchase. A software 

key is hardware locked to the computer on which it is used. A USB activation dongle can be added to the 

purchase. The dongle contains its own activation key and makes the license transportable from PC to PC. For 

more information on activation, see Chapter 4. 

Forensic Explorer customers: Please note that if you purchase Forensic Explorer (www.forensicexplorer.com) 

you will receive a USB activation dongle that contains a key for both Forensic Explorer and Mount Image Pro.  

3.1.2 PURCHASE ONLINE 

Mount Image Pro can be purchased online at http://www.mountimage.com. 

Forensic Explorer with Mount Image Pro can be purchased online at http://www.forensicexplorer.com. 

3.1.3 PURCHASE ORDERS 

Purchase Orders can be placed by Government and Corporate entities by contacting GetData head office: 

GetData Pty Ltd 

Suite 204, 13A Montgomery Street 

Kogarah,  

New South Wales, 2217 

Australia 

Ph: +61 2 82086053 

Fax: +61 2 95881195 

Email: sales@getdata.com 

Or by secure post: 

GetData Forensics Pty Ltd 

P.O. Box 71 

Engadine, New South Wales, 2233 

Australia 

Or via your forensic reseller. 

3.1.4  RESELLERS 

For a list of approved resellers, please contact GetData via: sales@getdata.com or via the contact details 

above. 

http://www.forensicexplorer.com/
http://www.mountimage.com/
http://www.forensicexplorer.com/
mailto:sales@getdata.com
mailto:sales@getdata.com
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3.1.5 PURCHASE MAINTENANCE 

A purchase of Mount Image Pro includes 12 months maintenance giving access to updates and support. The 

maintenance date is displayed on the Mount Image Pro splash screen: 

Figure 8, Mount Image Pro splash screen 

 

When the maintenance has expired, Mount Image Pro will continue to work, however you may only use the 

latest available version prior to the expiration of your maintenance period. 

To purchase additional maintenance online: 

1. Visit the following web page: www.mountimage.com;  

2. Select the option to purchase maintenance renewal; 

3. Complete the checkout process. 

Mount Image Pro maintenance is sold in increments of 1 year. 

To apply the maintenance update, follow the instructions in section 4.3.1. 

 

 

http://www.mountimage.com/
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4.1 ACTIVATION 

Mount Image Pro uses the Wibu Codemeter software protection system. If Mount Image Pro has not been 

activated, the following message is displayed: 

Figure 9, Running Mount Image Pro prior to activation 

 

To activate Mount Image Pro either a Software Key (referred to by Wibu Codemeter ŀǎ ŀ Ψ±ƛǊǘǳŀƭ 5ƻƴƎƭŜΩύ or a 

USB hardware dongle is required. 

A Software key is hardware locked to the computer on which it is entered. A software key can only be 

moved to another computer if it is first deactivated (see 4.2.3 below).  

 

A USB hardware dongle contains its own key. The dongle makes the key transportable from PC to PC. 

When the dongle is inserted, Mount Image Pro is activated. When the dongle is removed, Mount Image 

Pro returns to evaluation mode. 
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4.2 SOFTWARE KEY ACTIVATION 

IMPORTANT: Install and activate Mount Image Pro as Administrator of the local computer. It is NOT sufficient 

to be domain administrator. Domain administrators should run the installation executable as the local 

administrator (right click > run as > input local administrator credentials). 

To open the software activation window, select Help > Activate product as shown in the in Figure 10 below : 

Figure 10: Software Activation Window 

 

4.2.1 ONLINE ACTIVATION 

If the computer on which Mount Image Pro is to be activated is connected to the internet enter the sowftwae 

key into the field provided and click Next (as shown in Figure 11 below): 

Figure 11: Online activation, 14 day trial version 

 

A successful activation message will display the following screen, as shown in Figure 12 below: 
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Figure 12: Successful software key activation message 

 

4.2.2 OFFLINE ACTIVATION 

Where the computer on which the software is being installed is not connected to the internet, a separate 

internet connected computer can be used to activate. The activation process involves: 

¶ Exporting a license file from the software; 

¶ Uploading the license file, together with your purchase email address and license key at a web site 

(using any internet connected computer); 

¶ Downloading the validated license file and importing it back into the software. 

To activate an offline computer: 

1. Click the Offline Activation button and click Next; 



C h a p t e r  4 -  A c t i v a t i o n  2 3  |  P a g e 

 

 
© Copyright GetData Forensics 2002 - 2019, All rights reserved. 

Figure 13: Activation wizard 

 

2. Click on the Export button to export and save the license file "GetData.GDActRequest": 

Figure 14: Offline activation (evaluation version), export of license file 

 

3. Using an web browser on any internet connected computer, go to http://getdata.com/offline-

wibu.php and enter the required details: 

http://getdata.com/offline-wibu.php
http://getdata.com/offline-wibu.php
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Figure 15: Offline activation (evaluation version), upload of license file and activation details 

 

4. Click the Upload button to send the details to the activation server. The details are validated by the 

activation server and the file "GetData.GDActResponse" is returned to you. 

Figure 16, Offline activation (evaluation version), download of license file 

 

5. Save "GetData.GDActResponse" and take it back to the offline computer on which you will be 

activating the software. 

6. Once the "GetData.GDActResponse" file is back on the offline computer, click the Import button to 

import the file into the software. The software is now activated. 

4.2.3 DEACTIVATE A COMPUTER 

To remove a software activation key from a computer: 

1. An Internet connection is required; 

2. Download and run the GetData License Manager from 

http://download.getdata.com/support/LicenseManager.exe; 

3. In the left hand column of the License Manager click on the "GetData Virtual CmStick"; 

http://download.getdata.com/support/LicenseManager.exe
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4. Under the Product list you should see an entry for Mount Image Pro. Click on it to highlight it; 

5. Press the "Delete" button. A confirmation message will appear "The LicenseManager is now going to 

communicate with GetData License servers to update your dongle(s)". Click OK to proceed. 

6. ¢ƘŜ Ϧ5ŜōǳƎ [ƻƎϦ ǘŀō ǿƛƭƭ ǊŜǇƻǊǘ ǘƘŜ ǎǘŀǘǳǎΦ ! ǎǳŎŎŜǎǎŦǳƭ ǊŜƳƻǾŀƭ ƛǎ ƛŘŜƴǘƛŦƛŜŘ ōȅ Ϧ¦ǇŘŀǘŜ {ǳŎŎŜǎǎΗέΦ 

When you return to the "Dongles" tab, Mount Image Pro should no longer appear. 
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4.3 DONGLE ACTIVATION 

Mount Image Pro is activated using a Wibu Codemeter USB hardware dongle which is delivered to your by 

courier following your purchase (see Chapter 3 - Purchase, for more information on purchasing Mount Image 

Pro). 

The dongle contains its own activation key. The dongle makes the license transportable from PC to PC. When 

the dongle is inserted, Mount Image Pro is activated. When it is removed, Mount Image Pro returns to 

evaluation mode. 

The dongle has a unique identification number inscribed on the part of the dongle that is inserted into the USB 

port, as shown in Figure 17 below. Include this number in correspondence with GetData: 

Figure 17: Unique Wibu Codemeter dongle identification number 

 

The Wibu Codemeter dongle is driverless and requires no special installation. 

4.3.1 DONGLE MAINTENANCE 

Once a maintenance update has been purchased, to update maintenance on your Wibu Codemeter dongle: 

1. On a computer which has internet access, insert your Wibu Codemeter dongle into a USB port. 

Remove any other Wibu Codemeter dongles that you may have for other products. 

2. Run the GetData License Manager located in the installation folder of Mount Image Pro. The default 

location is: C:\ Program Files\ GetData\ Mount Image Pro vx\ License Manager.exe 

3. The GetData License Manager will detect your Wibu Codemeter dongle, as shown in Figure 18 below. 

The existing Maintenance expiration date is displayed in the Maintenance column:  
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Figure 18: GetData License Manager 

 

4. {ŜƭŜŎǘ άMount Image Proέ from the product list and press the ADD button. 

5. In the Add Licenses ǿƛƴŘƻǿΣ ŜƴǘŜǊ ǘƘŜ άLicenseέ ƪŜȅ that you received with your renewal order. Press 

the Search key. 

6. Select the renewal from the available product list. Then click the Apply button. 

7. Return to the main screen of the License Manager. Click the refresh button to display the new 

maintenance date. 

For further assistance in applying maintenance updates to your Mount Image Pro dongle, please contact 

support@getdata.com (see Appendix 1 - Technical Support for full contact details). 

  

mailto:support@getdata.com
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4.4 NETWORK ACTIVATION 

The Wibu Codemeter activation system enables you to use your local dongle to activate a remote internet 

connected computer: 

On the local computer with the Codemeter dongle is inserted run the Network Server: 

1. Download the latest Codemeter Runtime for Windows User from http://www.wibu.com/downloads-

user-software.html 

2. Run CodeMeter WebAdmin by browsing to http://localhost:22350/ConfigServer.html. 

3. Select Configuration > Server from the menu, as shown in Figure 19 below: 

Figure 19, CodeMeter WebAdmin 

 

4. In the Sever window heck Run Network Server and press the Apply button. 

5. Ensure that the selected Network Port 22350 is not blocked by your firewall. 

6. Restart the CodeMeter Service.  

a. Run the CodeMeter Control Center by clicking the CodeMeter icon in the Windows Task tray; 

b. Select Processes > Stop CodeMeter Service; 

c. Then Start CodeMeter Service. 

The Wibu CodeMeter Network Server can also be configured using the following registry setting: 

HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-SYSTEMS\CodeMeter\Server\CurrentVersion 

IsNetworkServer=1 

On the client computer: 

http://www.wibu.com/downloads-user-software.html
http://www.wibu.com/downloads-user-software.html
http://localhost:22350/ConfigServer.html
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7. Install Mount Image Pro. 

8. Browse to http://localhost:22350/Configuration.html: 

Figure 20, Wibu CodeMeter Local Host Configuration 

 

9. Click the add button and add the IP address of Network Server and press Apply. 

10. Start Mount Image Pro. It should detect the remote dongle license and activate. 

The client computer can also be configured using the following registry key setting: 

HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-

SYSTEMS\CodeMeter\Server\CurrentVersion\ServerSearchList\Server1 

Address=192.168.100.10 

 

http://localhost:22350/Configuration.html
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5.1 QUICK START 

5.1.1 IMPORTANT ς BEFORE YOU BEGIN 

Write Protect Physical Devices: 

An accepted principal of computer forensics is that wherever possible source data to be analyzed in an 

investigation should not be altered by the investigator. If physical media such as a hard drive, USB drive, 

camera card etc. is a potential source of evidence, it is recommended that when the media is connected to a 

forensics workstation it is done so using a write block device. See Appendix 2 - Write Blocking for more 

information. 

Virus & Malware 

An investigator should be aware of the inherent risks of mounting third party data to a forensic workstation. 

Appropriate virus and malware protection should be used at all times. 

5.1.2 QUICK START GUI MOUNT 

To mount a forensic-image from the GUI: 

1. Install Mount Image Pro (see Chapter 2); 

2. Activate  Mount Image Pro (see Chapter 4); 

3. To mount an image: 

a. In the top text menu of the GUI, select File > Mount Image File, and navigate to and open 

the required image: 

Figure 21, Mount Image file... 

 
 

Or;  

b. In the button toolbar, click Mount > Add Image, then navigate to and open the required 

image. The image will then be added to the Device Selection window. Once added, click the 

Mount button. 
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4. In the Mount window, select to mount as a Disk or File System (described in more detail in Chapter 6). 

Select the required options and click OK to mount. 

5. The image will then mount on the Windows File System and will be accessible via Windows Explorer 
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6.1 MOUNT TYPES ς SUMMARY 

Mount Image Pro offers different mount methods: 

¶ Disk (with our without Plug and Play); 

¶ File System. 

The following table provides a summary of the differences between these mount types: 

 Mount Disk File System 

Existing Windows security settings apply Yes No 

26 forensic-image limit (available drive letters) 
Yes 
(No if MIPDisk 
Folder is used)  

No 

Access entire physical drive with 3rd party tools Yes No 

Disk is shown in Windows Disk Management  
(* with PNP option) 

Yes No 

Display deleted files No Yes 

Display unallocated clusters as a file No Yes 

Display Windows system files (MFT, FAT, VBR etc.) No Yes 

More information about each mount type is provided below. 
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6.2 DISK 

Disk is used to mount a forensic-image and display the physical disk and / or partitions as if the physical drive 

were connected to the local computer.  

Disk with Plug-and-Play emulates the connection of a physical USB disk to the computer and adds the disk into 

Windows Disk Management. Plug-and-Play is used when the investigator needs access to the physical disk or 

partitions as a Windows managed drive. 

6.2.1 DISK - COMPATIBLE FORENSIC-IMAGE TYPES 

The Disk option can be used with the following forensic-images and devices:  

Disk  

Forensic-image of physical disk Yes 

Forensic-image of logical disk Yes 

Physical device (e.g. connected HDD) Yes 

Logical forensic-Image File (.AD1, .L01) No 

6.2.2 DISK - RECOMMENDATIONS 

When using the Disk option existing Windows security permissions inside the forensic-image are applied in the 

mount. Care must be taken to ensure access to all required data. It is recommended that: 

¶ Administrator access is used to examine a mounted image to ensure that maximum file security 

privileges are available; 

¶ Be aware that Windows will apply its exiting security schema to the mounted image; 

¶ Be aware of other Windows features such as Symbolic Links which may affect the way data is 

displayed. 

6.2.3 BITLOCKER DRIVES 

Mount Image Pro v7 supports the mounting of BitLocker encrypted partitions. BitLocker is a full disk 

encryption feature included with Windows Vista and later. It is designed to protect data by providing 

encryption for entire volumes. 

To mount a BitLocker drive, follow the Mount Disk instructions. The BitLocker partition will mount under 

Microsoft Windows and display the following folder icon: 

Figure 22, Window BitLocker drive icon 

 

When clicking on a BitLocker encrypted drive in Windows the following window should appear: 
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Figure 23, BitLocker password window 

 

You must have either the BitLocker password or a BitLocker Recovery Key to be able to access a BitLocker 

protected partition (see https://support.microsoft.com/en-au/help/17133/windows-8-bitlocker-recovery-

keys-frequently-asked-questions for more information) . 

Enter the BitLocker password or BitLocker recovery key to display the contents of the drive. 

 

  

https://support.microsoft.com/en-au/help/17133/windows-8-bitlocker-recovery-keys-frequently-asked-questions
https://support.microsoft.com/en-au/help/17133/windows-8-bitlocker-recovery-keys-frequently-asked-questions
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6.3 FILE SYSTEM 

File System uses the Mount Image Pro file-system driver to mount and display the contents of the forensic-

image. As Mount Image Pro has control, there is greater flexibility as to the way in which the contents of the 

forensic-image is displayed. 

The File System option is used to: 

¶ Over-ride Windows security permissions; 

¶ Mount File Systems that Windows does not recognize, e.g. APFS; 

¶ Override Windows folder management (symbolic links, hard links etc.); 

¶ Group multiple mounted image files under the one folder; 

¶ Control whether to display Windows system files; 

¶ Control whether to display deleted files. 

NOTE: File Systems are mounted as read only (i.e. it is not possible to delete items from the mounted Windows 

File System). 

6.3.1 FILE SYSTEM - COMPATIBLE FORENSIC-IMAGE TYPES 

The Mount Disk option can be used with the following forensic-images and devices:  

File System  

Forensic-image of physical disk Yes 

Forensic-image of logical disk Yes 

Physical device (e.g. connected HDD) Yes 

Logical forensic-Image File (.ad1, .l01) Yes 
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7.1 THE MOUNT IMAGE PRO GUI 

Important: It is recommended that Mount Image Pro be run as administrator to be certain that permissions 

enable access to physical devices and image files. 

For most users, the mounting and un-mounting of forensic-images or devices will take place in the Mount 

Image Pro GUI (Graphic User Interface). 

To open the Mount Image Pro GUI: 

¶ Run Mount Image Pro Windows Start menu; or 

¶ Double click on the desktop icon; or 

¶ If Mount Image pro is already running, double click on the MIP icon in the Windows Task Bar. 

The Mount Image Pro GUI is divided into 5 sections shown in Figure 24 below: 

Figure 24: Mount Image Pro GUI showing mounted images 

 

1. Title Bar:  

Shows the Mount Image Pro version number and activation status. 

2. Text Menu:  

Gives text menu access to program options, including: Mount; Unmount and Exit. 

3. Main Window:  

Lists the currently mounted forensic images or devices. 

4. Property Window: 

Lists the properties for the currently selected forensic-image in the Main Window; 

5.  Status Bar:  

Provides the status of the Mount Image Pro Disk and File System drivers. Provides the path to the 

currently selected forensic-image in the Main Window. 
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7.2 GUI MOUNT 

To mount a forensic-image using the GUI: 

1. From the top text menu, select File > Mount Image File, browse to and select the required image,  

then proceed to 7.2.2 below;  

2. Or, use the Device Selection window, described in xx below. 

7.2.1 DEVICE SELECTION WINDOW 

The Device Selection window is used to give access to: 

¶ Local physical devices; or, 

¶  Forensic-image files that have been previously added to the list. 

Figure 25: Mount Image Pro Device Selection window 

 

TO SELECT A DEVICE TO MOUNT 

To mount a local device; 

1. In the Device Selection window (shown in Figure 25 above), expand My Computer using the plus icon 

and select the required Hard Disk or logical drive letter and click the Mount button. 

TO ADD A FORENSIC-IMAGE TO MOUNT 

1. In the Device Selection window click on the Add Image button; 

2. Browse to the required image and select Open. The forensic-image is then added to and becomes 

available in the Device Selection window. Once added, the forensic-image will remain in the Device 

Selection window for quick reference until it is removed. 
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3. Select the required image and click the Mount button. 

7.2.2 MOUNT OPTIONS 

The Mount window is then displayed which gives a choice of mount type, Disk or File System and 

configuration options. 

Figure 26: Mount options window  

 

 

 

 

Location or Drive Letters: 

Automatic: 

Mount Image Pro will select the next available drive letter to commence mounting partitions. 

Select a drive letter: 
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The user selects the drive letter of the mount. If multiple partitions are to be mounted, the selected 

drive letter is the starting drive. 

Additional Location or Drive Letter options are detailed below that are specific to Disk or File System mounts. 

DISK OPTIONS 

Disk is used to mount a forensic-image and display the physical disk and/or partitions as if the physical disk 

was connected to the local computer. (See ς Mount Types, Chapter 6 for more information on the difference 

between a Disk and a File System mount). 

The following Disk configuration options are provided: 

Location or Drive Letters (options specific to Disk): 

None (Physical Only) 

A drive letter will not be allocated. The physical disk only will be mounted. Use this option if a third 

party tool need only access the physical disk. 

MIPDISK Folder (non-plug-and-play) 

The disk will be mounted into a folder on the existing file system. The folder path is specified in the 

registry key: 

Computer\HKEY_CURRENT_user\Software\GetData\Mount Image Pro v7\Configuration 

Access Mode 

When using the Disk option (a partition within the image), it is possible to set the ά!ŎŎŜǎǎ aƻŘŜ" to 

either: 

Read Only:  

The partition is mounted as a read only drive where no changes to the mounted drive letter are 

possible. For example, if a user attempts to deleted a file on a mounted drive letter the Windows 

operating system will return a message the at the drive is read only; 

Write to Null: 

All disk writes are dropped. Windows caches changes made to the mounted drive. For example, if a user 

deletes a file in the mounted image, the file is deleted from the mounted drive. Note that it is NOT 

possible to change the content of the image file. When the image is remounted, all files will be re-

displayed. 

Write to Cache: 

See Cache Folder below. 

Sector Size 

The sector size of the image can be adjusted for certain image types, e.g. DD, ISO. 

Plug-and-Play 
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Plug-and-Play emulates the connection of a physical USB disk to the computer. Windows is responsible 

for the management of the mounted image. One advantage is that the disk is added to Windows Disk 

Management giving the investigator access to the physical disk at a system level.  

Important considerations when using Plug-and-Play 

Display of hidden and system partitions: 

When Plug-and-Play is used Windows may not display hidden or system partitions. In the example 

below the forensic-image 1406JT03.E01 of a Windows 8 computer is first mounted using Plug-and-Play 

and then mounted again without:  

 

The Plug-and-Play mount allocates F:\  drive to data partition. Additional Windows Recovery and system 

partitions are shown in the GUI but are not allocated drive letters. The Non-Plug-and-Play mount 

allocates J:\  drive to data partition and also allocates G:, H:, I:, K:, L: to the Windows Recovery and 

system partitions. 

Disk Signature Collisions 

A disk signature is a άfour-ōȅǘŜ ƛŘŜƴǘƛŦƛŜǊ ƻŦŦǎŜǘ лȄм.у ƛƴ ŀ ŘƛǎƪΩǎ aŀǎǘŜǊ .ƻƻǘ wŜŎƻǊŘΣ ǿƘƛŎƘ ƛǎ ǿǊƛǘǘŜƴ ǘƻ 

the first sector of a disk. Windows uses disk signatures internally to map objects like volumes to their 

underlying disks and starting with Windows Vista, Windows uses disk signatures in its Boot 

Configuration Database (BCD), which is where it stores the information the boot process uses to find 

ōƻƻǘ ŦƛƭŜǎ ŀƴŘ ǎŜǘǘƛƴƎǎέ (1) 

A Disk Signature Collision means that Mount Image Pro will not PNP mount the same disk twice. 

ά²ƛƴŘƻǿǎ ǊŜǉǳƛǊŜǎ ǘƘŜ ǎƛƎƴŀǘǳǊŜǎ ǘƻ ōŜ ǳƴƛǉǳŜΣ ǎƻ ǿƘŜƴ ȅƻǳ ŀǘǘŀŎƘ ŀ Řƛǎƪ ǘƘŀǘ Ƙŀǎ ŀ ǎƛƎƴŀǘǳre equal to 

one already attached, Windows keeps the disk ƛƴ άƻŦŦƭƛƴŜέ ƳƻŘŜ ŀƴŘ ŘƻŜǎƴΩǘ ǊŜŀŘ ƛǘǎ ǇŀǊǘƛǘƛƻƴ ǘŀōƭŜ ƻǊ 

Ƴƻǳƴǘ ƛǘǎ ǾƻƭǳƳŜǎέΦ  ¢ƘŜ ǎƻƭǳǘƛƻƴ ŘŜǎŎǊƛōŜŘ ŘŜǘŀƛƭ ƛƴ aŀǊƪ wǳǎǎƛƴƻǾƛŎƘΩǎ .ƭƻƎ 

(http://blogs.technet.com/b/markrussinovich/archive/2011/11/08/3463572.aspx) is to use Windows 

5ƛǎƪ aŀƴŀƎŜƳŜƴǘΩǎ online menu option to generate a new random disk signature (note that the image 

cannot be mounted read-only for this method to be used). 

Cache Folder 

http://blogs.technet.com/b/markrussinovich/archive/2011/11/08/3463572.aspx
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The cache folder holds the location of the cache file. The default cache folder is the same path as the 

current image file. The cache path can be modified. The current value is stored in the registry key: 

Computer\ HKEY_CURRENT_USER\ Software\ GetData\ Mount Image Pro 

v7\ Configuration\ DefaultCacheDir 

A cache file is created when the Access Mode > Write to Cache menu option is selected. The cache file 

is named [Image Name].gdcache. A cache file stores any writes to the mounted Disk so that the 

mounted disk operates as an autonomous Read/Write disk. Any changes to the disk (e.g. file deletes) 

will be maintained in the cache file. 

IMPORTANT: If a disk is remounted and has an existing cache file from a previous mount, the new 

mount will reflect the changes made in the previous mount. To reset the disk to its original state, 

unmount the image, delete the cache file, and mount again. 

FILE SYSTEM OPTIONS 

File System: ǳǎŜǎ aƻǳƴǘ LƳŀƎŜ tǊƻΩǎ ƻǿƴ driver to display the content of the forensic-image. File Systems are 

always mounted as read only. (See ς Mount Types, Chapter 6 for more information on the difference between 

a Disk and a File System mount). 

Location or Drive Letters (options specific to Disk): 

The user selects the drive letter of the mount. If a previous File System has been mounted, the user can 

select an Existing drive and mount additional File Systems to it. Using this technique, a Filesystem 

mount is not limited by the number of drive letters available on the forensic workstation. 

Label 

This option sets the Windows label for the mounted disk. The default label is άaLt File System 5ƛǎƪέΦ 

Include Unallocated Files 

This option controls whether unallocated space is added to the mounted image. If checked, unallocated 

space is added as files, including a file for: 

¶ Unallocated clusters 

¶ Lost OS clusters 

Include Deleted Files 

This option controls whether deleted files are added to the mounted image (Deleted files are those that 

have a valid file system record, e.g. a MFT record, that marks the file as deleted). Deleted files are 

shown in the mounted image in Windows Explorer with άώ5ŜƭŜǘŜŘϐέ ŀǇǇŜƴŘŜŘ ǘƻ ǘƘŜ ŦƛƭŜ ƴŀƳŜΦ  

Show System Files 

This option controls whether system files are included in the mounted image. System Files include: 

¶ Orphaned: Orphans are deleted folders and files for which the original parent folder is unknown. 

¶ NTFS Volume Boot Record. 
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Remove Hidden Attributes (Recommended) 

Checking this option removes the Windows hidden attribute from mounted files so that they are 

visible under Windows. 

Remove System Attributes (Recommended) 

Checking this option removes the Windows system attribute from mounted files so that they are 

visible under Windows. 

Click OK to mount the image or device. 

7.2.3 MOUNTED IMAGES AND DEVICES 

Mounted devices or images are then displayed in the Mount Image Pro GUI Main Window, as shown in Figure 

27 below: 

Figure 27: Mount Image Pro GUI showing 3 mounted image files 

 

The mounted drives will now be available on the local File System. Right click on the image and select Explore 

from the menu to quickly access the image contents in Windows Explorer.  

Figure 28: Windows Explorer showing the 3 mounted image files listed in Figure 27 above 

 

7.3 GUI UNMOUNT 

To unmount from the GUI: 

¶ Right click on the device or image and select Unmount or Unmount All from the drop down menu; or; 
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¶ Click the Unmount icon and select Unmount or Unmount All from the drop down menu. 

When Mount Image Pro is exited, all existing mounts are unmounted. 

7.4 GUI VIEW 

The View button in the toolbar enables the addition of the device or image to the Mount Image Pro GUI 

without mounting the image.  This option is used to view the properties of the device or image in the GUI. 

 

Use unmount to remove a viewed image from the GUI. 

7.5 GUI OPTIONS 

To set GUI options, click on the Options button in the toolbar: 

 

Figure 29: Mount Image Pro Options window 

 

Auto mount on program start: 

When this option is selected Mount Image Pro will attempt to remount the currently mounted 

devices or images when Mount Image Pro is next started. 

The following Mount Image Pro exit confirmation message is displayed when this option is active: 
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Figure 30: Exit confirmation message - Mount on start 

 

Stay on top: 

This option forces the Mount Image Pro GUI to stay at the top of all other onscreen windows. 

Remember position and size of program window: 

Preserves the current size and position of the GUI for next launch. 

Logging: 

Generates a log to the specified file. 
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8.1 MOUNT MAC HFS/APFS 

Two different methods are used to mount a MAC drive on a Windows computer: 

1. File System using the Mount Image Pro HFS driver (recommended); 

2. Disk with a third party file system driver installed on the forensic workstation. 

More information is provided below. 

8.1.1 MAC ς FILE SYSTEM - USING MIP DRIVER 

To mount using the Mount Image Pro MAC HFS file system driver:  

1. Follow the mount instructions in section 7.2 above. In the mount Options window select File System; 

2. The MAC partitions will be available under the MIP Filesystem Disk, as shown in Figure 31 below:  

Figure 31: Mount File System for a MAC HFS drive 

 

View the MAC files in Windows Explorer: 

Figure 32: Windows Explorer showing a MAC drive mounted as a File System 
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8.1.2 MAC - DISK ς THIRD PARTY FILE SYSTEM DRIVER 

If third party MAC file system driver is used, the EXTFS Windows Pro driver from Paragon Software is 

recommended (http://www.paragon-software.com/home/hfs-windows/). 

To mount and display files using a third party file system driver:  

1. Ensure that the MAC third party driver is installed and running; 

2. Follow the mount instructions in section 7.2 above. In the mount Options window select Disk without 

plug and play; 

Figure 33: MAC drives mounted as Disk 

 

The third party driver will detect and display the MAC file system: 

Figure 34: MacDrive displaying the contents of a MAC drive Disk mount 

 

 

 

http://www.paragon-software.com/home/hfs-windows/
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9.1 MOUNT DD FORENSIC-IMAGES 

A single RAW or DD forensic-image can be mounted normally using the GUI or Command Line interface. 

A segmented RAW or DD forensic-images ending with the extensions .001, .002, .003 etc. can be mounted 

normally using the GUI or Command Line interface. 

9.1.1 MOUNT A SEGMENTED DD IMAGES USING A DESCRIPTOR FILE 

If the image segments do NOT have .001, .002, .003 etc. extensions, follow these instructions: 

Creating a Descriptor File 

The descriptor file is a text file that contains a list of all raw forensic-images that make up the complete image 

set. The file extension of the descriptor file should always be '.RAW', even though it is a text file. Inside the text 

file are the ordered list of the file names of the individual files that make up the entire image. 

How to Create Your Descriptor File 

A descriptor file is a plain text file which simply lists forensic-image names. Blank lines and leading/trailing 

blanks are allowed and lines starting with # are ignored as comment lines. Any combination of Carriage Return 

and Line Feed are allowed as new line delimiters. 

Relative paths in a descriptor file are resolved first from the current directory, then from the descriptor file's 

location. 

If the size of the described forensic-image is not a multiple of 512, the capacity of the file is rounded down to a 

multiple of 512 and exceeding area is not used. E.g. if a file is 5200 bytes, it is treated as a 5120 byte file: 

Example of a Descriptor File: 

# This is a comment line 

image01.dat 

image02.dat 

image03.dat 

This file should be saved as "descriptor-file.raw". The file can be saved in any location on your drive. Make sure 

it contains a valid path to the location of the image segments. Then run Mount Image Pro and select the 

descriptor file as the file to mount. 
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10.1 RAID - INTRODUCTION 

Mount Image Pro supports the analysis of the following types of RAID: 

JBOD 

JBOD (Just a Bunch of Disks) is a term to describe the grouping of odd-sized drives into one larger useful drive. 

For example, a JBOD could combine 3 GB, 15 GB, 5.5 GB, and 12 GB drives into a logical drive at 35.5 GB, which 

is often more useful than the individual drives separately. 

RAID 0 

A RAID 0 (also known as a stripe set or striped volume) splits data evenly across two or more disks (striped) 

with no parity information for redundancy. It is important to note that RAID 0 was not one of the original RAID 

levels and provides no data redundancy. RAID 0 is normally used to increase performance, although it can also 

be used as a way to create a small number of large disks out of a large number of small physical ones. 

A RAID 0 can be created with disks of differing sizes, but the storage space added to the array by each disk is 

limited to the size of the smallest disk. For example, if a 120 GB disk is striped together with a 100 GB disk, the 

size of the array will be 200 GB. 

RAID 1 

RAID 1 is a mirrored set with parity. Typically, it consists of two physical drives, one being an exact copy of the 

other. The RAID Array continues to operate so long as at least one drive is functioning. Using RAID 1 with a 

separate controller for each disk is sometimes called duplexing. 

RAID 5 

A RAID 5 uses block - level striping with parity data distributed across all member disks. Distributed parity 

means that if a single drive fails the array is not destroyed. Upon a drive failure, any subsequent drive reads 

can be calculated from the distributed parity of the functioning drives. A single drive failure in the set will 

result in reduced performance of the entire set until the failed drive has been replaced and rebuilt. 

10.2 PREPARATION 

When dealing with RAID drives, care should be taken in the forensic acquisition phase to document as much 

information as possible as to the RAID configuration. 

Successful RAID setup in Mount Image Pro will be assisted by knowledge of the following: 

¶ Is it a hardware or software RAID? (A hardware RAID usually has a separate RAID controller card); 

¶ What is the RAID format, JBOD, RAID 0, 1, 5, other? (Are the drives in the raid identical in size and 

capacity? This information may be obtained from the system administrator or setup documentation). 

¶ What is the RAID stripe size? (this information may be determined from the RAID controller) 

¶ How many physical disks make up the RAID? 
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¶ What is the sequence of the physical disks in the RAID? (Noting or photograph the RAID controller 

port numbers may assist to determine drive sequence). 

¶ Is the RAID complete and functioning? Are there missing drives? 

10.3 MOUNTING A RAID 

A RAID can be constructed and added to Mount Image Pro using: 

1. Physical disks (Note: When using physical disks a hardware write blocking device is recommended to 

preserve forensic integrity); 

2. Forensic Forensic-images; or, 

3. A combination of both physical disks and forensic forensic-images. 

To add a RAID drive to a case: 

1. Click the button to add a device to the current case. 

2. In the Device Selection window, click on the  button. This opens the RAID 

configuration window. 

10.3.1 HARDWARE RAID, KNOWN CONFIGURATION:   

Enter the RAID configuration information: 

  

and follow the instructions to add and test the RAID: 

HARDWARE RAID, UNKNOWN CONFIGURATION:   

If you do NOT know the parameters of your hardware RAID drive, Mount Image Pro will attempt to 

identify the way in which the RAID was configured. To do this: 

1. Set the RAID type to "hardware"; 

2. Add the drives (or forensic-images) in the correct sequence, or, if the correct sequence is 

unknown, add them in the order that is believe to be most correct; 
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3. Click on the "Find Layout" button to find a suggested configuration. A suggested configuration is 

indicated by a green tick next to each added drive. 

Important: 
 
A suggested configuration is based on the information available from the drives. However, due to the 
complexity of a RAID structure, there may be more than one configuration that returns this result. A suggested 
configuration should be tested by adding the image to the case to determine if individual files can be accessed 
and previewed. 
  
If Find Layout did not return a suggested configuration, or,  
The suggested configuration did not result in a successful recovery; 
 
If the Find Layout button did not return green ticks for each added drive, or the continued recovery from a 
suggested configuration did not work, try the following: 
 

1. click on the "Probable Solutions" tab to view suggested configurations for the RAID; 
2. change the "stripe size", RAID Options and drive sequence as suggested; 
3. click the "Test Layout" button to test the modified configuration; 
4. add the RAID drive to the case. 

10.3.2 SOFTWARE RAID 

If it is a software RAID: 

1. Set the "Type" of RAID to "software". 

2. Press  to confirm a valid software RAID.  A valid software RAID will show with green 

ticks on the added drives (or forensic-images): 

 

10.3.3 ONCE THE CORRECT RAID LAYOUT IS IDENTIFIED 

Once the correct RAID layout has been identified, click OK to add the configured RAID drive to the Device 

Selection window. 
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Select the RAID drive and click OK to add the drive to the case. 

Once the RAID drive is added, select and preview individual files to ensure that the RAID drive is correctly 

configured and access to all files in the RAID has been achieved. 
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Chapter 11 ς Network Devices 

 

In This Chapter 

CHAPTER 11 ςNETWORK DEVICES 

11.1 Mount a Remote Network Device ..................................................................................................... 67 
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11.1 MOUNT A REMOTE NETWORK DEVICE 

Mount image Pro has the capability to mount remote device across a network using 

the UDP protocol (User Datagram Protocol is one of the core members of the Internet 

Protocol Suite). 

To mount a network device: 

1. Run the GetDataNetworkServer.exe on the remote computer (this file is located in the Mount Image 

Pro installation folder). The following screen appears; 

 

 

2. ¢ƘŜ ǎŜǊǾŜǊ ŜƴǘŜǊǎ άǿŀƛǘƛƴƎέ ƳƻŘŜ ŦƻǊ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ŦǊƻƳ Mount Image Pro. 

Note: It may be necessary to configure firewall settings on the remote computer to enable remote 

access to the GetData UDP Network Server. 

3. In the Device Selection window, click on the Network button to open the Remote Server Connection 

Settings window: 
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Figure 35: Network Mount - Remote Server Connection Settings 

 
Server IP Address:  

Enter the IP address of the remote computer as displayed in the Server IP filed of the GetData UDP 

Network Server.  

Port:   

Ensure the Port number uses the same port as the GetData 

UDP Network Server.  

4. Click the Connect button to view the available physical and logical devices on the remote computer. 

Select the required device and click OK. The selected device should now appear under the Networked 

section of the Device Selection window, as shown below: 




































































